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FrameMaker is a
complete solution
for creating
publication-quality
documents of any
type. FrameMaker
seamlessly combines
advanced word
processing, page
layout, and graphics
in a single, easy to
learn and use
package.

Word processing
¥ Paragraph and

character
formatting

¥ Spell checking
and hyphenation
in 12 languages

¥ Find and change
text using wild-
card characters,
formats, and more

¥ Footnotes
automatically
renumber

¥ Automatic change
bars

¥ Automatic save

¥ Conditional text
for creating
different versions
of a single
document

Page layout
¥ Typographic

controls, such as
character, word,
and line spacing

¥ Kerning and
ligatures

¥ Font sizes from 4
to 400 points in.
001Ó increments

¥ Shared page
layouts and
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formats between
documents

¥ Baseline
alignment across
columns; vertical
justification

¥ User-defined page
size

¥ Mixed portrait and
landscape pages in
a single document

¥ Rotated text

¥ Cross-references
within and across
multiple files

¥ Tables that are
easy to create,
edit, and design

¥ Document
templates

¥ Freeze pagination
to control text
flow

Graphics
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¥ Tools for drawing,
scaling, rotating,
aligning, and
evenly spacing
graphics

¥ Bezier curves

¥ User-defined line
widths and
arrowheads

¥ Anchor graphics
to text, or place
them directly on
the page

¥ Spot color
separations

¥ Import graphics in
the following
formats: PICT,
EPSF, TIFF,
MacPaint, pcx,
GIF, Sun
Rasterfile, xwd

¥ Import graphics
by reference, or
copy them into a
document
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Book building
¥ Table of contents

and index
generation for
documents and
books

¥ Integrated book
building, with
paragraph
numbers,
pagination, and
cross-references
updated across
documents in a
book

¥ Include chapters
from different
computers
(Macintosh and
UNIX) across a
network

¥ Add, delete and
rearrange chapters

¥ Generate a list of
fonts used in a
document
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Éand more
¥ WYSIWYG math

editor

¥ Product training
from Frame
Authorized
Training Centers

¥ Product support
by phone and e-
mail

¥ Available on
multiple
platforms; NeXT,
SunView, X-
windows and
OpenLook
versions available

To continueTo go to the next
page, click the Next
Page icon at the
bottom of the
document window ()
.

Some FrameMaker features
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Personalize this session
Later in the demonstration, youÕll see how FrameMaker refers to
your name.
To personalize your session with this document:

1. Point to the right of Demo done by: and click.

The insertion point appears.

2. Type your name.

Getting help
If you want more information on a topic, choose Help from the
Apple menu for on-line Help (created with the FrameMaker
hypertext feature).

To continueTo go to the next page, click the Next Page icon at the bottom of the
document window ().If you have an extended keyboard, you can press Page Down.

The PremierWorkstation Publishing Company

Before you begin

Demo done by:
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Are you spending too much time creating documents? Use a
FrameMaker template to create professionally formatted documents
as fast as you can type.
In this exercise, all you do is type and press the Return key. The
document template provides the format.

1. Point in the blank area under TO: and click.

2. Type a name and press Return.

FrameMaker supplies the next heading.

3. Type a name beside FROM: and press Return.

4. Type a few words beside RE: and press Return.

FrameMaker supplies the next heading and a rule.

5. Type a name beside CC: and press Return.

6. Type a few words.Now that youÕre in the body of the memo, each paragraph uses the
same format until you choose a different one. To learn how to
change the format of a paragraph, go to the next page.
TO:

A document in minutesMake your paragraphs look their best. Try one of the many formats
provided with FrameMaker, or create your own.
To change a paragraph format, choose one from the ¦ (Paragraph
Format) Catalog, as follows:1. Click the paragraph icon on the right side of the document

window.
The ¦ Catalog appears.

2. Put the insertion point in the top line of text in the example.

3. In the ¦ Catalog, click Heading. FrameMaker reformats the
paragraph with the insertion point.

4. To undo the change, choose Undo from the Edit menu.

5. To close the ¦ Catalog, click its close box.6. Go to the next page.
Report from the National Endowment for the Arts
The National Endowment for the Arts is pleased to present the attached report on
arts education. In this report we:
1. Identify the arts that should be taught in school.
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2. Show why the present state of arts education is unsatisfactory and suggest
avenues for its improvement.

3. Explain the present state of arts curriculum, testing, evaluation, and research.
4. Examine the role of the National Endowment.In Summary
The following excerpts are from the Introduction. I have included them here
because our group feels they summarize our findings elegantly and concisely.
We need to help our children move toward civilization. As we stand on the
threshold of the 21st century, we are concerned, and rightly so, with the quality of
the education of young Americans and whether it is preparing them for the
challenges of the future.
Many of the challenges will, obviously, be scientific and technologicalÑand our
schools must give our children the tools to deal with them. Less obvious, many of
the challenges will be cultural.
Craig Stanion
Chairman
National Endowment for the Arts

Stored paragraph formats
Make your text sparkle with font sizes from 4 to 400 points and your
choice of styles.
To change the format of selected text, give it a character format, as
follows:1. Click the Character Format Catalog icon on the right side of the

document window.
The Ä (Character Format) Catalog appears.

2. Put the insertion point in the top line of text (with the words, The
Arts Endowment).

3. Triple-click to select the line.

4. In the Ä Catalog, click Big Title.

The font size is now 44 points.

5. Double-click a word in the main text of the report.

6. In the Ä Catalog, click Emphasis.
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FrameMaker changes the character format of the selected text.
7. Close the Ä Catalog and go to the next page.THE ARTS ENDOWMENTA Report

Prepared by the Chairman

of the National Endowment for the Arts

December 1982

LEGISLATIVE BACKGROUND

Difficult as it is to pinpoint the beginning of new eras, it is clear
that after World War II a new and closer relationship developed
between the federal government and the arts.
President Eisenhower was the first of several presidents to take
significant steps to draw the two together. Announcing in a State
of the Union address that Òthe Federal government should give
official recognition to the importance of the arts and other
cultural activities,Ó Eisenhower in 1958 signed a law creating a
national cultural center. Later named the John F. Kennedy
Center of the Performing Arts, it opened its three performance
halls and exhibit areas in Washington D.C. in 1971.
President John F. Kennedy, responding to a report called The
Arts and the National Government, established the Advisory
Council on the Arts by the executive order in 1963. Kennedy
was assassinated before he had appointed the members of the
council.

Words that stand out
Repeating titles and column headings, table formats, and other
features help you create tables easily.

Adding text is as easy as typing in a cell.
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1. Click in the cell with the word Resistor and type some text.
The text wraps in the cell, and the row expands.

2. To make new rows, hold down Control and press Return. Make
enough rows to continue the table on the next column.

To change the tableÕs format:

1. Click in any cell.

2. Choose Table Format from the Table menu.

The Table Format window appears. The tableÕs current format
(Format A) is selected in the Table Catalog scroll list.

3. In the scroll list, select Format B.

4. Make sure the checkboxes are set as follows:

5. Hold down Shift and click Apply To.

FrameMaker reformats the table.

6. Close the Table Format window and go to the next page.
Electronic Symbols
The following table is a list of electronic symbols and their
definitions.Table 1.
Common
Symbols
SymbolDefinitionResistorCapacitorDiodeCoilGround

Tables with ease
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Number footnotes the way you
want them: numeric, Roman,
symbol, or a combination.
When you rearrange text
containing a footnote,
FrameMaker renumbers the
footnotes.

To add a footnote:

1. Put the insertion point in the
paragraph indicated with the
arrow.

2. Choose Footnote from the
Special menu.

A new footnote number
appears at the bottom of the
page.

3. Type: This is a footnote.

4. To move the insertion point
back to the last paragraph,
use the keyboard shortcut for
the Footnote command:
press Command-E.

5. To select the entire

FrameMaker $paratext
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paragraph, point on it and
triple-click.

6. Choose Cut.

7. Put the insertion point at the
beginning of the first body
paragraph.

8. Choose Paste.

FrameMaker pastes the
paragraph in the column and
renumbers the footnotes.

1. Ecological damage
Ecologists will have to fill gaps both on the applied and
basic research level to meet the needs society has asked
them to satisfy.Michigan Environmental Review Board
The State of Michigan in an attempt to perform such an

integration has several avenues to resolve
environmental conflicts: legislated standards, the
Environmental Protection Act, and the Michigan
Environmental Review Board.

Cooper uses his experience as Chairman of this Review
Board in providing his views on environmental
assessment. This BoardÕs recommendations, which
arise from review of impact statements, directly enter
the administrative structure via the GovernorÕs office.
Methodology
Burns emphasizes the necessity of using sublethal and
chronic toxicity data in making impact assessments. To
some degree this is due to technological improvements
making acute toxicity problems less of a consideration.
Most importantly however is the fact that the science
has passed the point where we must rely on acute
lethality data in making predictions .

Sublethal and Chronic Toxicity
The sublethal toxicity levels will assure that the the
several substances do not exceed a permissible
concentration: These gross effects studies provide only
crude evaluations.

This impact may, however, be of no significance at the
pollution or community level which is where the
assessment emphasis should be placed. He further
provides some examples of studies where sublethal

. Present address: Council on Environmental Quality.
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effects have had a large impact at the "pupulation"
levels.

Footnotes made easy
FrameMaker doesnÕt just check your spelling. It questions repeated
words, extra spaces, unusual punctuation, irregular hyphenation, and
much more.
To spell check a page:

1. Put the insertion point in the sample text.

2. From the Edit menu, choose Spelling Checker.

3. In the Spelling Checker window, click Options.

The Spelling Checker Options dialog box appears.

4. Survey the many options available, and then click OK.

5. In the Spelling Checker window, turn on Check Current Page.
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7. There are five errors in the sample. Each time FrameMaker finds
an error, click Correct.

8. Close the Spelling Checker window and go to the next page.

More than a spelling checker
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FrameMaker can number paragraphs, such as section titles, lists,
equations, figures, tables, and footnotes.
If you rearrange numbered paragraphs, FrameMaker renumbers
them.

1. Triple-click the paragraph indicated with an arrow.

2. Choose Cut.

3. Put the insertion point at the beginning of the paragraph
numbered 1-1.1a.The insertion point appears after the number.

4. Choose Paste.With paragraph numbering like this, imagine how quickly you can
create outline-like numbering.
1. Put the insertion point at the end of the heading

1-1 Introduction.

2. Press Return four times.FrameMaker numbers each new paragraph.Text that no longer fits on the page flows to the next page.

1 Biological evaluation of environmental

impact

1-1 Introduction
The symposium on Biological Evaluation of Environmental Impact, was
organized by the PresidentÕs Council on Environmental Quality (CEQ)
and hosted by the Ecological Society American Institute of Biological
Sciences.

1-1.1 National Environmental Policy Act
This symposium focused on:

1-1.1a. How the biological significance of
environmental impacts can be both evaluated by
ecologists and described to decision-makers in the
environmental impact assessment process.
1-1.1b. How can the biological significance of
environmental perturbations be evaluated?
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1-1.1c. How can these evaluations by the PresidentÕs
Council on Environmental Quality (CEQ) be
meaningfully described in order to enlighten and
influence public decision-makers in the environmental
impact assessment process?
1-1.1d. How to facilitate the immediate exchange of
information.
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1-2 Evaluation focus
The importance and value of this process, as well as its points of
weakness, are well-known to the nationÕs ecologistsÑa sizable number
of whom have participated in it. The symposium permitted ecologists to
voice their views on improving the process.
Given the wide range of topics chosen by the authors, there is no attempt
to synthesize the various ideas into a central theme.
Also, since the various authors frequently disagreed in their points of
view, it seemed unfair to pull together a set of recommendations from the
individual papers, since it would not permit contributing authors with
differing perspectives to rebut the collective result.

1-3 Symposium goals
There were several goals to this symposium. The first was to facilitate the
immediate exchange of information concerning the present state of
impact assessment. This was accomplished at the 1976 AIBS meeting.
That is the purpose of these Proceedings. And thirdly, the CEQ staff
wished to avail itself of the best current thinking on the topic for the
CouncilÕs work on environmental assessment and monitoring.

1-4 Disclaimer
The summarized concepts presented below do not constitute am
endorsement of the ideas of the individual authors, but rather are offered
as a means of stimulating further discussion and improvement in our
ability to evaluate environmental impacts.
Also, since the various authors frequently disagreed in their points of
view, it seemed unfair to pull together a set of recommendations from
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the individual papers, since it would not permit contributing authors with differing
perspectives to rebut the collective result.

1-5 Philosophical overview (see Section 1-4 Disclaimer)
The environmental movement is an expression of social consciousness.
An outgrowth of this movement has been a variety of environmental laws
and regulations as well as a recognition that for long-term planning and
policy formulation, long-term tracking of environmental trends is needed.
Environmental assessment programs seek to satisfy these needs.
While many of the papers in this symposium address specific
methodology questions, present cases studies, or discuss individual
monitoring problems, this first group of papers sets a perspective for the
whole assessment process because that authors place the technical
process of data collection in the context of the scientific and societal
framework from which the process sprang.

1-5.1 Õs study
HinckleyÕs contribution growing out of the Institute of
EcologyÕs Environmental Impact Assessment Project is based
on the assumptions that the principles and methods of ecological
analysis are valuable for the assessment of technological impacts,
and that a summary of ecological analysis methods may increase
their application under the provisions of NEPA.

1-5.1a. What he states is needed is impact assessment at
the ecosystem and regional level, with biotic diversity
treated as a nonrenewable resource, rather than an
analysis that consists of little more than a species list.
1-5.1a(i) However even though ecological analysis can
help predict adverse impacts to human health and welfare,
the prediction cannot be complete because of insufficient
baseline information, the stochastic nature of ecological
change, and the imperfect link between ecological effects
and their socioeconomic consequences.

Paragraph numberingWhen was that document last changed? FrameMaker knows. Use
variables to insert the current date, modification date, document
name, page number, or paragraph text. Even create your own
variables.
In the sample document, the header and footer contain variables.
Notice the current date in the header and the text of heading 1-4
Disclaimer in the footer.
1. Double-click heading

1-4 Disclaimer to select it.

2. Press Delete.

3. Type FrameMaker.

4. To update the footer with the text you typed, press Control-L to
redisplay the page.

Automatic textSee Figure 8 in Chapter 3.2, ÒCircuits.Ó Do you avoid cross-
references because theyÕre too hard to maintain? FrameMaker
maintains them for you. And you can even cross-reference paragraph
text, paragraph numbers, and page numbers across documents.
The text in italics beside the 1-5 heading is a cross-reference to a
heading you changed on the previous page. To update the cross-
reference:
1. In the section 1-5 heading, point on the cross-reference (itÕs in

italics) and double-click.

The Cross-Reference dialog box appears.

2. Click Update.

FrameMaker $paratext
[Section] 8



3. In the Update Cross-References dialog box, click OK.
FrameMaker updates the cross-reference.4. Click Cancel in the Cross-Reference dialog box.
Notice also that your name is now a part of the heading for
section 1-5.1. The heading includes a cross reference to page 3,
where you typed your name.5. Press Control-L to update the cross-reference in the sample
documentÕs footer.

Cross-referencesLoading theDynaLoadster Van

Your DynaLoadster Van is designed to carry a payload anywhere
you need to go. With 4-wheel drive, extra high clearance, and the
new DynaPower 6-cylinder engine, you can take your load past any
obstacle.
Weight SpecificationsMaximum Payload363 kg (800 lbs.)Curb Weight1316 kg (2902 lbs.)Max Total Weight1679 kg (3702 lbs.)Cover Your LoadIt is against the law in many

states to carry an uncovered
load. Be sure to cover your
load and secure it with
DynaLoadster Tiedowns

(optional).

You might have separate documents for similar products, such as the
ownerÕs manual on the right. You can keep both manuals in one
conditional document.
To change to the ownerÕs manual for a pickup truck:

1. Choose Conditional Text from the Special menu.

The Conditional Text window appears.

2. Click Show/Hide.

The Show/Hide dialog box appears.

3. Select Van in the Show scroll list and click the arrow that points
to the right.

4. Select Pickup Truck in the Hide scroll list and click the arrow
that points to the left.

Pickup Truck is now in the Show list and Van is in the Hide list.
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5. Click OK
Now you see the ownerÕs manual for the pickup truck. Notice
the changes that appear in the title, body, and table.

6. Close the Conditional Text window.Conditional text
Use FrameMaker to anchor a graphic to text or a page.
To see graphics flow with the text:

1. Put the insertion point in the first line of the first body paragraph.

2. Press Return four times.

Notice the graphics moving with the text, and the text filling the
left column when the graphic moves to the right column.

Those graphics are anchored to the text. The rotated graphic in the
left margin doesnÕt move because it isnÕt anchored to the text.

To copy a graphic into the text:

1. Click on the rotated text in the left margin.

Handles appear around the object.

2. Choose Copy.

3. Put the insertion point in the right column.

4. Choose Paste.

FrameMaker anchors the copied graphic in the text and turns on
the borders. The border around each graphic is an anchored
frame.
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To turn off borders:
1. From the View menu, choose Borders.Evaluation of Stress Intensity FactorsOne of the strongest features of the NASCRAC code is the wide range of stress
intensity factor solutions it contains. The code utilizes both closed-form K-
solutions and influence functions.
Through the use of influence functions, a very wide range of crack configurations
and stress systems can be analyzed. Table 1 summarizes the stress intensity factor
solutions included in the code and indicates the configurations for which influence
functions and J-integral solutions are also available.
In the event that the crack configuration to be analyzed cannot be idealized into
one of the current existing solutions within the NASCRAC code, the code also has
the capability to generate a new influence function. The new influence function
can then easily be incorporated into the userÕs version of the code, thereby
expanding the library of available solutions.
The value of K due to a stress o(x) on the crack surface is then given by an
equation.
The influence function results are made more convenient for use by curve-fitting
the point-wise results to an assumed functional form. The NASCRAC code
incorporates an assumed functional form suitable for surface-connected cracks or
buried cracks with symmetry with respect to the crack midpoint.
The procedure for automated generation of planar influence functions has been
incorporated into the NASCRAC code and was demonstrated in Reference 9 by
application to two problems: an edge-cracked strip and an edge-cracked disk.
Alternative influence functions exist for the edge-cracked strip [14], as well as
stress intensity factor solutions for uniform and linearly varying tension [6]. Stress
intensity factor solutions exist for the edge-cracked disk only under uniform and
parabolic tension [6]. As reported in Reference 9, influence functions were
generated for both geometries using the Williams-series expansion truncated at 50
terms. The influence function for the edge-cracked strip was compared directly to
the influence function of Orange [14] and excellent agreement was observed.
Graphics that flow with text
FrameMaker makes it easy to experiment with page layout. You can
resize, split, and connect columns of text. You can combine multiple
columns of different widths on the same page.
To resize a column:

1. Point in the left column, hold down the Option key, and click.

Handles appear on the text columnÕs border.2. Drag the lower middle handle down the page.
Text fills the column.To split one column into two:

1. Click in the right column.2. From the Page menu, choose Column Connections.3. In the Column Connections dialog box, turn on Split into
Columns and Click OK.
FrameMaker splits the column.

The two changes to column layout you made can be done in one step
by applying a different layout from a master page. This enables you
to quickly see what a document would look like with different
column layouts. You can also copy page layouts between documents.IntroductionThe increasing need for high reliability in a wide variety of lightweight aerospace
structures has lead to increasing requirements for techniques for analysis of crack
behavior. In conjunction with this, the large number of components requiring
analysis has led to a need for easily-implemented standard procedures employable
by a number of users.
A user-oriented comprehensive fracture mechanics code employing state-of-the-
art procedures for analysis of crack growth would provide the necessary tool.
The purpose of this paper is to describe such a tool, which has been developed by
Failure Analysis Associates (FaAA) for NASA-Marshall Space Flight Center. The
code is called NASCRAC; an acronym for NASA CRack Analysis Code.
Portions of the code have been described in an earlier paper, and this paper will
concentrate on aspects of the code not emphasized earlier. The primary function of
the NASCRAC code is analysis of fatigue crack growth under linearly elastic
conditions. In order for this to be accomplished for a wide range of geometries and
stress systems, many capabilities are necessary.
One example is the use of influence functions for evaluation of stress intensity
factors for complex stress distributions. The code concentrates on fatigue crack
growth under Mode I (opening mode) loading. This is the loading mode that drives
fatigue cracks, and growing fatigue cracks orient themselves so as to grow under
Mode I conditions [2,3].
In addition to provisions for analysis of fatigue crack growth, many other features
useful for analysis of cracks are included in the code. Figure 1 provides a block
diagram of types of analysis that the code is capable of performing, with the areas
receiving special emphasis in this paper indicated by an asterisk.

NASCRAC:

A Fracture Mechanics Analysis Code
Custom page layouts
Importing graphics is easy. Use the same command to import
graphics in the following formats: PICT, EPSF, TIFF, MacPaint,
pcx, GIF, Sun Rasterfile, and xwd. Also, you can scale, crop, rotate,
and annotate imported graphics.
To import a graphic on this page:

1. Click the border of the rectangle to the right to select it.

2. Choose Import from the File menu.

The Import dialog box appears.

3. Be sure MacPaint is on.

4. Select the file named DemoGraphic.

5. Click Import.

A dialog box appears.

6. Turn on 72 dpi, and click OK.

The graphic appears on the page.

You can use a frame to crop an imported graphic:

1. Select the rectangle.2. Drag a handle to make the rectangle smaller.
Notice how the frameÕs border crops the graphic.

Imported graphics
With FrameMaker you can draw bezier curves, rotate text, design
arrowheads, flip, align, scale, and much more.
To flip a picture:

1. Click the drawing of the ship to select it.

2. From the Graphics menu, choose Flip Horizontally.

To draw an object:1. Click the Tools icon on the right side of the document window.
The Tools palette appears.

2. Click the paletteÕs zoom box to open the large Tool palette.

The Graphics commands are listed in the large Tools palette.3. Click the Arc drawing tool.
4. Click the thickest line width and the line ending with an arrow,

as circled below.

5. Point in the blank area to the right and hold down the mouse
button.

6. Drag diagonally down to draw an arc with an arrowhead.
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7. Close the Tools palette and go to the next page.

Graphics with pizzazz
You can combine several FrameMaker documents into a book, and
generate tables of contents and indexes. Managing books is easy:
you can open, save, or print all documents in a book with one
command.
YouÕll generate a table of contents from this demo document that
includes the heading at the top of each page (such as Books, at the
top-left of this page).

Add some text to the heading of this page, Books, as follows:

1. Click to the right of Books above this column.

2. Type some text. (It will appear in the table of contents you
create.)

To generate a table of contents:

1. From the File menu, choose Generate.

The Generate dialog box appears.

2. Click Generate.

The Set Up Table of Contents dialog box appears.

3. Click OK.

FrameMaker generates and opens a table of contents.Notice that the text you typed appears in the table of contents.To close the table of contents:
1. Click its close box.
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2. In the dialog box that appears, click No.
IndexA
automatic text 11B
books 18C
catalogs

Character 6
Paragraph 5

character formats 6
clip art 20
cross-references 12D
document templates 4E
equations 19F
footnotes 8
FrameMaker

basics 3
features 2

FrameMath 19G
graphics 2, 17

flow with text 13
imported 16

Books
FrameMaker Demonstration
FrameMath is your integrated solution to typesetting equations.
Type, edit, format, evaluate, and solve equations.
Everything you need to create equations is available in the Equations
palette. To open the Equations palette:1. Click the Equations icon on the right side of the document

window.
The Equations palette appears.

2. To see a different page in the Equations palette, click an item in
the list in the middle of the palette. The items are labeledSymbols, Operators, Large, etc.To evaluate the derivative in the first expression:

1. Put the insertion point in the equation.2. Press the space bar until the entire equation is selected.3. Press Esc M V D.To insert symbols and operators in the equations:
1. Click an equation.2. Click a symbol or operator in the Equations palette.3. Close the Equations palette and go to the next page.

(1)
(2)
(3)

To multiply the matrices in the third equation, select the left side of
the equation and press Esc X A.

A big plus: FrameMathª
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Evaluating which publishing
software to use is difficult.
Feature lists are long and
difficult to compare.
To help you decide which
publishing software is best for
you, hereÕs a checklist of key
questions. The answers will help
determine the strength of the
software youÕre considering.1. Can you create, edit, and
publish your documents within
one application, or do you need
one product for word processing,
and another for layout and
document formatting?2. Can you execute all
commands from the keyboard
and the mouse?3. Can you zoom in on any
page, whether it has text or
graphics? Can you display
facing pages? Can you edit
while in thumbnail view?4. Are tables integrated? Do the
tables automatically paginate?
Can you create automatic ruling
and shading for tables? Can you
change table formats the way
you change paragraph formats
(with a click of the mouse)?5. Does the spelling checker
catch common typos such as
double spaces, straight quotes,
and spaces before punctuation?6. Can you search for
automatic hyphens, change bars,
and text within index markers?
Can search strings include
wildcards? Can you replace text
with a graphic?7. Can you include multiple
cross-reference points in a single
cross-reference? (See Figure 3,
ÒFluid Flow,Ó in Section 7,
ÒFluid AnalysisÓ on page 7-5.)8. Is conditional text part of the
application? Can you selectively
view different versions of a
document made from a single
base document?9. Can you mix portrait and
landscape pages in a single
document? Are there master
pages to automatically apply
layouts for left, right, divider,
and other pages?10. Are change bars
automatic? Can you adjust their
thickness, color, and position to
identify different authors? Can
you clear them in one step?11. Do you need to reformat
a table of contents or index each
time you update its content?12. Can many dialog boxes
remain open while you edit text?13. Can you create hypertext
documents?14. Can text flow between
columns of different widths?
Can you have more than one
story in a document? Can you
continue a story on any page?15. Are there versions of
your publishing application
available for other platforms or
environments? How many? Are
the document files from those
versions completely compatible
with all other versions of the
software? Do you need to
ÒconvertÓ your document files
to open them on other
platforms?16. Is the company whose
software youÕre considering
committed to technical support?
Does it provide E-mail support?

Evaluation checklist
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More things to
see
This demonstration
document shows
only a few of the
many FrameMaker
features. For a
complete list,
request a
FrameMaker data
sheet.

You can also
exploreFrameMaker
on your own. On-
line Help is
available by
choosing Help from
the Apple menu.

On-line documents
shipped with
FrameMaker
include:

¥ Document
templates. Choose

FrameMaker $paratext
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New from the File
menu to see a list.

¥ Clip art.

Choose Open
from the File
menu and open the
Clip Art folder in
the FrameMaker
folder. The clip art
documents appear
in the scroll list.

To zoom this

document
To see a reduced
view of this
document:

¥ At the bottom of
the document
window, point on
100%, hold down
the mouse button,
and choose 25%
from the pop-up
menu.To return,
select 100% from
the menu.
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To close this

document
Click the close box
in the document
window. Click No in
the dialog box that
appears.

To quit
FrameMaker
Choose Quit from
the File menu.

Training
Frame also offers
product training
through Authorized
Training Centers.

For the location of
the nearest Frame
Authorized Training
Center, call:

1 (800) U4Frame

FrameMaker $paratext
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Thanks for trying
FrameMaker!
To get your copy of
FrameMaker today,
contact a Macintosh
software dealer.

To learn more about
FrameMaker,
contact us:

Phone: (408) 433-
3311

FAX: (408) 433-
1928

Mail:
Frame
Technology Corp.
1010 Rincon
Circle

San Jose, CA
95131-1325

AppleLink:

FRAME.TECH

Electronic mail:

FrameMaker $paratext
[Section] 10



comments@frame.
com

Frame bulletin
board:

(408) 433-4841

For more information
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